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Заимствовано из технической записки Keysight EEsof EDA: Пример разработки маломощного 
смесителя с использованием Advanced Design System

Введение
В этом разделе описывается метод разработки маломощного однотранзисторного 
активного смесителя с помощью системы Keysight Advanced Design System (ADS). Раздел 
содержит подробное пошаговое описание процесса разработки, схем для симуляции 
и дисплеев данных. Файл рабочей среды, о которой идет речь в данной лабораторной 
работе, доступен в директории примеров ADS /examples/ RF_Board/MixerPager_wrk.7zaps. 
Разархивируйте данный файл в рабочую директорию, воспользовавшись меню File > 
Open > Example > RF_Board > MixerPager_wrk.7zaps (Файл > Открыть > Пример > РЧ плата 
> MixerPager_wrk.7zaps) и далее выбрав рабочую директорию для разархивирования 
данного примера рабочей среды. Чтобы увидеть все содержание ячейки, в главном меню 
ADS нажмите на стрелку рядом с каждой папкой, как показано на рисунке ниже.
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Технические требования к схеме
Смеситель – это понижающий преобразователь с выходом на верхней боковой частоте 
с РЧ 900 МГц и ПЧ 45 МГц. Упрощенные технические требования для данной разработки 
заключаются в том, что она должна обеспечивать усиление преобразования 10 дБ при 
работе с питанием от 1 В постоянного напряжения при токе 600 мкА. Такое очень низкое 
энергопотребление типично для таких областей применения, как пейджеры и мобильные 
телефоны, где решающую роль играет время работы от батареи. Низкая стоимость – еще 
один определяющий фактор в таких задачах. Другие типичные требования, с которыми 
столкнулся бы смеситель в практических устройствах, такие как линейность, развязка 
между портами, паразитный отклик и коэффициент шума, в этом конкретном примере 
не рассматриваются. Примеры того, как включить симуляцию этих характеристик в свою 
разработку, можно найти в /examples/ RFIC/Mixers_wrk.7zap.

Выбор компонента
Одним из первых шагов процесса разработки является выбор компонента. Для данного 
примера использован компонент MMBR941 компании Motorola – биполярный плоскостной 
транзистор в стандартном пластиковом корпусе SOT-23. Хотя биполярные транзисторы 
обычно обладают не настолько хорошими смесительными свойствами, как полевые, 
в данном случае применение полевого транзистора исключается низким рабочим 
напряжением. Выбранный компонент имеет приемлемые рабочие характеристики 
для данной задачи и обладает несколькими дополнительными преимуществами: он 
очень дешевый, а его точные модели легко доступны. Практическим правилом для 
крупносерийных экономичных изделий является использование наиболее дешевого 
компонента, который будет справляться со своей работой, и транзистор MMBR941 – это 
хороший выбор для данного смесителя. Так же верно и то, что вне зависимости от того, 
насколько хорош компонент, его невозможно использовать в разработке, если нет 
моделей, с помощью которых можно выполнять его симуляцию.

Модель компонента, взятая из библиотеки ADS RF Transistor (РЧ транзисторы), является 
моделью Гуммеля-Пуна, параметры которой были получены производителем – компанией 
Motorola. Сначала проверяются рабочие характеристики модели по постоянному току 
путем сравнения кривых в координатах ток-напряжение (I-V) в режиме постоянного тока. 
Далее будет разработана схема смещения для задания желаемой рабочей точки. Затем 
будет проверено поведение модели на радиочастоте путем сравнения S-параметров, 
полученных при симуляции, с измеренными S-параметрами, полученными при таких же 
смещениях. Наконец, нелинейные характеристики модели будут проверяться с помощью 
симуляции компрессии коэффициента усиления и сравнения с результатами измерений.

Проверка характеристик модели компонента по постоянному току 
(ячейка: DC_curves)
Ячейка DC_curves (см. рис. ниже) отражает один из способов выполнения анализа 
постоянного тока со свипированием параметров. Питание постоянного тока на коллекторе 
задается переменной VCE, которая инициализирована в блоке VAR (Переменные). 
В блоке VAR также инициализируется переменная IBB, используемая в источнике 
постоянного тока на базе биполярного транзистора. Фактические значения переменной 
VCE определяются в контроллере симуляции постоянного тока DC1. В данном примере 
переменная VCE свипируется от 0 до 6 В, так что модель можно проверить в относительно 
широком рабочем диапазоне. Контроллер постоянного тока может свипировать 
только одну переменную, поэтому переменная IBB свипируется с помощью компонента 
ParamSweep (Свипирование параметра). Диапазон, выбранный для тока базы IBB, задан 
равным 50...350 мкА. Эта схема симуляции характеристики I-V доступна в ADS как шаблон 
по умолчанию, и разработчики могут получить ту же схему на странице Schematic (Схема), 
выбрав: Insert > Template > BJT Curve Tracer (Вставить > Шаблон > Характериограф 
биполярного транзистора), и она может использоваться после задания значений 
переменных IBB и VCE в соответствии с пожеланиями разработчика.
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Результаты данной симуляции показаны в “DC_curves.dds”. Имеющиеся выходные 
переменные можно просмотреть либо вставив новый график, либо отредактировав 
имеющийся график. При этом откроется диалоговое окно Insert Plot (Вставить график), 
показанное на рис. 226. Обратите внимание, что напряжения в каждом именованном узле 
добавляются автоматически, как и ток источника постоянного тока (VCC.i).

Данные токового щупа ICC.i в данном случае излишни. Нумерованные узлы используются 
для хранения информации для данных аннотации постоянного тока, о чем пойдет речь в 
разделе «Проверка РЧ характеристик модели компонента».

Рис. 225. Схема для анализа транзистора по постоянному току со свипированием параметров.

Рис. 226. Диалоговое окно вставки графика.



07 | Keysight | Разработка активного смесителя – Руководство с демонстрационными примерами

Из рис. 227 видно, что результаты симуляции хорошо согласуются с измерениями. Данные 
измерений могут быть считаны в ADS из любых файлов данных или приборов, для чего 
нужно выбрать Window > New File/Instrument Server (Окно > Новый файл/Приборный 
сервер). ADS преобразует файлы в формате Touchstone, MDIF, Citifile или ICCAP в наборы 
данных ADS, которые могут быть затем отображены одновременно с результатами 
симуляции. Кривые I-V ясно показывают, что в заданной рабочей точке VCE=1 В, ICE<0,6 мА 
компонент будет работать в слаботочном режиме. Если у разработчиков нет файлов 
данных измерений, этот шаг можно пропустить.

Разработка схемы смещения (ячейка: BiasPoint)
Следующий шаг – выбор рабочей точки компонента и расчет требуемых резисторов 
смещения – выполняется с помощью схемы ячейки Bias-Point, показанной на рис. 228. 
Поскольку напряжение и ток коллектора уже заданы, необходимо определить только ток 
базы. В данной схеме значение VCC зафиксировано на уровне 1 В, а IBB свипируется от 1 
до 10 мкА с помощью контроллера постоянного тока.

Рис. 227. Сравнение кривых при постоянном токе для транзистора MMBR941, полученных путем 
измерений (кружки) и симуляции (непрерывные линии).

Рис. 228. Расчет точки смещения.
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Схема содержит компоненты цепи смещения (DC_Feed и DC_Block) и 50-омные нагрузки, 
имитирующие реальную испытательную схему, применявшуюся для измерения 
параметров компонента. Однако, поскольку симуляция постоянного тока не включает 
каких-либо РЧ сигналов, эти компоненты на данный момент не нужны, и без них можно 
обойтись без влияния на результаты. Результаты отображаются в табличной форме в 
BiasPoint.dds (см. рис. 229), благодаря чему может быть выбран подходящий ток базы. 
Обратите внимание, что ток точки смещения на самом деле ниже заданного конечного 
значения. Причина этого в том, что компонент будет накачиваться относительно большим 
сигналом гетеродина, что будет приводить к уходу постоянной составляющей тока 
коллектора.

Этот уход будет позднее рассчитан более точно, но на данный момент значение IBB 
выбрано равным 5 мкА, так что соответствующий ток коллектора (514 мкА) значительно 
ниже заданного в характеристиках.

Далее рассчитываются номиналы резисторов смещения, показанных на рис. 230. Ток базы, 
ток коллектора и напряжение VCC известны, но разработчик должен принять решение 
относительно падения напряжения на резисторе Rc, чтобы получить возможность 
вычислить номиналы Rc и Rb. В данном случае напряжение коллектор-эмиттер 
выбрано равным 0,75 В, что обеспечивает приемлемое рабочее напряжение на выходе 
и осуществимые номиналы резисторов. Выражения, приведенные на странице дисплея 
данных, позволяют рассчитать точные номиналы, необходимые для получения каждого 
значения тока базы, но само собой, выбрать необходимо ближайшие стандартные 
значения. Следующим шагом является подтверждение работы смещения при данных 
стандартных номиналах и последующая проверка S-параметров модели по измеренным 
значениям.

Рис. 229. Выбор рабочей точки компонента.

Рис. 230. Расчет резисторов схемы смещения.
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Проверка РЧ характеристик модели компонента (ячейка: BiasNet)
Ячейка BiasNet, показанная на рис. 231, включает симуляцию как постоянного тока, так 
и S-параметров, поэтому в данном случае компоненты цепи смещения (пропускающие 
и блокирующие постоянное смещение) уже необходимы, чтобы обеспечивались 
правильные рабочие РЧ характеристики. Результаты для постоянного тока отображаются 
непосредственно на странице схемы с помощью функции аннотации результатов 
симуляции постоянного тока: как только симуляция будет запущена, выберите Simulate > 
Annotate DC Solution (Симуляция > Аннотация результатов симуляции постоянного тока), и 
вы сможете увидеть постоянные напряжения и токи в каждом узле. Эта симуляция может 
быть выполнена как при точных номиналах резисторов, так и при ближайших стандартных 
значениях (Rc=470 Ом, Rb=8,2 кОм), чтобы подтвердить правильность рабочей точки.

S-параметры компонента для данной рабочей точки рассчитываются и отображаются 
вместе с данными измерений, как показано на рис. 232. Полученное здесь хорошее 
соответствие подтверждает рабочие малосигнальные РЧ характеристики. Далее будет 
выполнена симуляция компрессии коэффициента усиления схемы для проверки работы 
при большом сигнале.

Рис. 231. Схема для симуляции постоянного тока и S-параметров.

Рис. 232. Сравнение S-параметров транзистора MMBR941, полученных с помощью измерений и 
симуляции.
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Проверка схемы в режиме большого сигнала (ячейка: Compression)

Ячейка Compression (рис. 233) демонстрирует два способа расчета компрессии 
коэффициента усиления на частоте 900 МГц. Традиционный способ, реализованный 
здесь с помощью контроллера гармонического баланса, заключается в свипировании 
уровня мощности входного сигнала от низких (т. е. малосигнального режима) до высоких 
значений, пока не возникнет компрессия коэффициента усиления (начнет снижаться 
отношение Pout/Pin относительно своего значения при малом сигнале). Выполняется 
свипирование переменной входной мощности PwrIn от –45 до –15 дБм, и выходная 
мощность в дБм при 900 МГц определяется с помощью компонента Measurement Equation 
(Выражение для измерения). Заметьте, что для функции мощности в дБм предполагается, 
что сигнал подается на нагрузку 50 Ом, если иное не задано пользователем. Аргумент 
функции HB.Vout[1] задает основную частоту. На рис. 234 показано выражение и график, 
которые используются для определения точки компрессии по уровню 1 дБ, а также 
приведены результаты измерений.

Второй способ, присущий только ADS, – более прямой. Он не требует применения графиков 
или свипирования переменных. Контроллер Gain Compression (Компрессии коэффициента 
усиления) XDB выполняет анализ методом гармонического баланса, при котором 
корректно рассчитываются и выдаются уровни входной и выходной мощности в заданной 
точке компрессии. Значение по умолчанию составляет 1 дБ, но пользователь может задать 
любую величину компрессии. На рис. 234 также показаны результаты данного метода: 
уровни входной и выходной мощности при компрессии 1 дБ приводятся в дБм.

Рис. 233. Схема для измерения компрессии коэффициента усиления.

Рис. 234. Два способа определения точки компрессии 1 дБ. Оба выдают значение входной мощности 
P1, равное –24 дБм.
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ADS обеспечивает высокую гибкость в отношении того, где и как описываются выходные 
данные. В качестве простого примера: параметр PwrOut был задан на странице схемы с 
помощью компонента MeasEqn, но его с тем же успехом можно было описать на странице 
дисплея данных в виде выражения. Преимущество выходных данных, описанных на 
схеме, заключается в том, что их можно использовать при оптимизации. С другой стороны, 
описание их на странице дисплея данных полезно для задания шаблонов (когда сложные 
вычисления могут быть легко применены ко множеству различных схем). Также любые 
выходные параметры, которые были упущены из виду до запуска симуляции, могут быть 
рассчитаны позже путем добавления их на странице дисплея данных.

Обратите внимание, что на данном этапе в проекте все еще используются идеальные 
компоненты в цепи смещения для разделения трактов постоянной и РЧ составляющих. 
На следующей стадии разработки они будут заменены более точными моделями 
компонентов, формирующих схему согласования.

Разработка схемы согласования смесителя
Важным шагом в разработке смесителя является определение импедансов, которые 
наблюдаются на каждом из портов как для РЧ, так и для ПЧ. Окончательная входная схема 
будет обеспечивать согласование базы транзистора с импедансом 50 Ом на радиочастоте 
и представлять собой короткое замыкание на промежуточной частоте (во избежание 
усиления какого-либо шума на входе и создания им помех ПЧ на выходе). Аналогично, 
выходная схема будет согласовывать коллектор с импедансом 50 Ом на ПЧ, при этом 
являясь коротким замыканием на РЧ. Таким образом, для каждой частоты нагрузки 
на входе и выходе компонента совершенно разные. Поскольку компонент не является 
однонаправленным, наличие короткого замыкания с одной его стороны будет оказывать 
влияние на импеданс, наблюдаемый с другой стороны при обеспечении согласования.

Итак, первый шаг разработки схемы согласования входа – определение входного 
импеданса компонента на РЧ при коротком замыкании на выходе. Для создания 
схемы согласования выхода разработчику необходимо знать выходной импеданс 
биполярного транзистора на ПЧ при коротком замыкании на входе. В ADS для симуляции 
идеализированных частотнозависимых нагрузок такого типа применяются компоненты 
Z-параметра с одним портом, основанные на выражениях, как это представлено в ячейке 
RFIFmatch1 (см. рис. 235).

Рис. 235. Расчет импеданса компонента для разработки схемы согласования.
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Компоненты Z1P_Eqn описаны в блоке VAR. Компонент ZIN во входной части схемы 
настроен так, чтобы представлять собой короткое замыкание на ПЧ и разомкнутую 
цепь на РЧ. Аналогично, компонент ZOUT в выходной части схемы является коротким 
замыканием на РЧ и разомкнутой цепью на ПЧ. Также обратите внимание, что источник 
сигнала гетеродина на этом этапе представлен идеальной нагрузкой 50 Ом, связанной 
со смесителем через конденсатор 0,5 пФ. Данная емкость выбрана такой малой для того, 
чтобы изолировать источник сигнала гетеродина от входного сигнала РЧ. Обратные 
потери в обратном направлении через конденсатор в сторону источника сигнала 
гетеродина составляют на РЧ всего 0,33 дБ, поэтому для поступающего сигнала РЧ это 
выглядит почти как разомкнутая цепь. Расплата за это – то, что гетеродин, работающий 
на частоте, близкой к РЧ, будет также изолирован от схемы, что означает необходимость 
в более высоком уровне сигнала гетеродина. Например, если уровень источника сигнала 
гетеродина задан равным –10 дБм, до смесителя дойдет сигнал с уровнем всего –22 дБм.

Результирующие S-параметры на РЧ показывают, что входной импеданс при коротком 
замыкании на выходе составляет (11,5 – j51,4) Ом. На ПЧ выходной импеданс равен 
(2065 – j2010) Ом. Эти значения можно использовать для принятия решения о структуре 
и номиналах компонентов схемы согласования. У разработчика при создании схемы 
согласования всегда есть выбор из нескольких структур, и то, какая из них будет 
наилучшей, зависит от таких факторов, как достижение максимального выхода годных 
(некоторые структуры более чувствительны к разбросу параметров компонентов, чем 
другие), сведения к минимуму количества компонентов (для снижения стоимости) и, 
где возможно, сочетания различных функций (в данном случае, встраивания в схему 
согласования компонентов развязки постоянного смещения).

Чтобы это проиллюстрировать, на рис. 236 показано, что исходя из входного импеданса 
компонента (A) параллельная индуктивность после последовательной индуктивности 
успешно сместит импеданс из точки B1 в точку 50 Ом. Полученная схема “A” имеет 
некоторые преимущества: параллельная индуктивность, как и требовалось, обеспечит 
короткое замыкание на ПЧ на входе, и при этом она может использоваться в схеме 
развязки постоянного смещения (заменяя идеальный компонент DC_feed). Однако 
схема “B” еще лучше: применение параллельной индуктивности с меньшим номиналом 
смещает импеданс в точку B2, в которой согласование обеспечивается с помощью 
последовательного конденсатора. Конденсатор C2 также может служить для блокировки 
постоянной составляющей, что позволяет сэкономить один компонент, так что для 
смесителя будет использоваться эта схема. ADS предоставляет простой в использовании 
инструмент диаграмм Смита, который может применяться для разработки схем согласования.

Рис. 236. Выбор топологии схемы согласования входа.
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Схема согласования выхода была создана с использованием подобного подхода: исходя 
из диаграммы Смита была разработана схема согласования, состоящая из параллельной 
индуктивности, установленной после последовательного конденсатора. Однако данная 
структура приведет к тому, что любой сигнал РЧ на выходе будет попадать на нагрузку, 
вместо того чтобы, как задумывалось, для него схема была коротким замыканием. Чтобы 
решить эту проблему, параллельная индуктивность (изначально с номиналом около 
910 нГн – очень большой импеданс на РЧ) заменяется на эквивалентное параллельное 
сочетание индуктивности и емкости (LC). Конденсатор должен иметь достаточно большой 
номинал, чтобы на РЧ обеспечивать условия, близкие к короткому замыканию. Было 
выбрано значение 33 пФ. Затем уменьшается параллельная индуктивность, так что 
общее реактивное сопротивление, обеспечиваемое парой LC на ПЧ, было таким же, как у 
исходной индуктивности.

Хотя в этом примере это проделано не было, фактические номиналы компонентов для этой 
схемы могут быть рассчитаны с помощью ADS, как это показано в таких примерах, как  
/examples/MWCkts/ LNA_wrk. В данном случае компоненты были рассчитаны вручную  
с помощью диаграммы Смита, а полученная схема показана в ячейке LOdrive. 
Окончательные схемы согласования показаны на рис. 237. Обратите внимание, что кроме 
компонентов схем согласования и смещения, был добавлен нагрузочный резистор RL для 
управления усилением преобразования смесителя. Исходный номинал 4,7 кОм был выбран 
достаточно большим, чтобы не оказывать влияния на рабочие характеристики смесителя, 
а когда усиление преобразования будет известно, он будет скорректирован в соответствии 
с требованиями. Также добавлено два больших пропускающих РЧ конденсатора (BlkL1 
и BlkL2), чтобы обеспечить заземление на РЧ для выходного нагрузочного резистора и 
индуктивности и для параллельной индуктивности на входе соответственно.

Рис. 237. Схемы согласования смесителя.
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Зависимость усиления преобразования смесителя от уровня сигнала 
гетеродина (ячейка: LOdrive)
Ячейка LOdrive (рис. 238) демонстрирует, как выполнять симуляцию усиления 
преобразования смесителя и как определить влияние уровня сигнала гетеродина на 
усиление и постоянное смещение. Частоты сигналов РЧ и гетеродина и уровень мощности 
гетеродина были описаны как переменные. Уровень сигнала РЧ задан равным –50дБм, 
тогда как контроллер гармонического баланса настроен для свипирования уровня 
сигнала гетеродина от –30 до –5 дБм. (У данного контроллера есть множество параметров, 
и пользователь может управлять тем, какие из них будут отображаться на схеме, путем 
редактирования компонента, выбрав страницу “Display” (Отображение) в диалоговом 
окне редактирования). Выражение для измерений при симуляции описывает выходную 
мощность в дБм на ПЧ. Ее описание в этом месте вместо страницы дисплея данных 
позволяет при необходимости выполнить оптимизацию для выходной мощности ПЧ. 
Функция “mix” будет возвращать составляющую спектра Vout, заданную как {–1, 1}, что 
означает {–Freq[1]+Freq[2]} или –LO+RF= IF (45 МГц).

Выражение P_IF рассчитывает значение функции mix в дБм.

На дисплее данных отображается влияние нагрузочного резистора (рис. 239).

Поскольку усиление преобразования представляет собой разницу между P_IF и RF, а 
мощность РЧ зафиксирована на уровне –50 дБм, усиление преобразования может быть 
рассчитано с помощью простого выражения. Обратите внимание, что набор данных 
по умолчанию LODrive содержит результаты для нагрузочного резистора 4,7 кОм, а 
усиление преобразования для данной симуляции рассчитывается с помощью выражения 
“ConvGain”. Усиление преобразования при уровне сигнала гетеродина –10 дБм составляет 
17дБ, что неприемлемо много. Вторая симуляция была выполнена с нагрузочным 
резистором, уменьшенным до 1,5 кОм, что создало рассогласование с потерями на выходе. 
Результаты данной симуляции были выведены в набор данных LOdrive15. Выражение 
“ConvGain_Rl5kOhm” показало, что усиление преобразования снизилось до 13,7 дБ. Это 
все еще больше, чем заданная в технических требованиях величина 10 дБ, но на данный 
момент это значение будет сохранено, поскольку ожидается, что усиление преобразования 
в дальнейшем уменьшится, когда идеальные компоненты будут заменены неидеальными 
компонентами поверхностного монтажа.

Второй график дисплея данных, показанный на рис. 239, иллюстрирует влияние уровня 
сигнала гетеродина на постоянное смещение. Увеличение сигнала гетеродина на 
базе приводит к большему размаху выходного сигнала на коллекторе, смещая вверх 
постоянную составляющую (см. рис. 240). На практике, сдвиг тока смещения коллектора на 
5 – 15% обычно придает хорошие рабочие характеристики смесителю такого типа.

Рис. 238. Схема для симуляции смесителя со свипированием уровня сигнала гетеродина.
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Рис. 239. Изменение усиления преобразования и тока смещения с изменением уровня сигнала 
гетеродина.

Рис. 240. Изменение выходного тока коллектора с изменением уровня сигнала гетеродина.
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Зависимость усиления преобразования смесителя от уровня сигнала 
РЧ (ячейка: MixCompr)
Схема для измерения компрессии коэффициента усиления преобразования смесителя, 
использованная в ячейке  MixCompr, очень похожа на схему LOdrive за тем исключением, 
что теперь мощность гетеродина задается постоянной на уровне –10 дБм, а мощность 
сигнала РЧ свипируется от –50 до 0 дБм. Как показывают результаты, представленные на 
рис. 241, компрессия коэффициента усиления преобразования смесителя достигает 1 дБ 
при уровне входного сигнала –27 дБм.

Теперь, когда рабочие характеристики смесителя проверены, следующим шагом является 
замена идеальных пассивных компонентов на реалистичные модели резисторов, 
конденсаторов и индуктивностей поверхностного монтажа, которые будут применяться в 
реальной схеме.

Создание топологии смесителя (ячейка: MixerLayout)
Топология и схема содержатся в ячейке MixerLayout. Существует множество возможных 
способов создания топологий, и какой из методов лучше, зависит от конкретной задачи. 
В данном примере первым шагом была замена всех компонентов схемы на их ближайшие 
аналоги из числа компонентов поверхностного монтажа в библиотеке Passive Component 
(Пассивные компоненты). Далее, эти компоненты были размещены в окне топологии 
в своих приближенных позициях. Межсоединения были выполнены в окне топологии 
с помощью команды Trace (Проводник) или микрополосковых компонентов, и было 
скорректировано окончательное размещение компонентов. Наконец, с помощью функции 
синхронизации проекта была обновлена схема.

Ячейка MixerLayout была создана путем сохранения схемы ячейки MixCompr под новым 
именем и ее изменения. Поскольку симуляция окончательной схемы будет выполняться 
с использованием топологического представления, ее необходимо вставить в другую 
схему в виде подсхемы. Причина этого в том, что файл топологии не может содержать 
контроллеров симуляции, источников и нагрузок. Первый шаг – удаление таких 
компонентов из схемы и добавление портов в каждой точке схемы, к которой будет 
выполняться внешнее подключение либо к источникам, либо к земле, либо к другим 
схемам. Когда подсхема будет вставлена в другую схему, на используемом символе 
подсхемы появятся метки каждого порта, поэтому следует задать осмысленные имена. На 
этом этапе разработчик может также создать собственный символ для подсхемы, выбрав 
View > Create/Edit Schematic Symbol (Вид > Создать/редактировать символ схемы).

Рис. 241. Компрессия коэффициента усиления преобразования смесителя.
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Следующий шаг – замена всех резисторов, конденсаторов и индуктивностей моделями 
компонентов поверхностного монтажа, которые будут использоваться в реальной 
схеме. Все модели можно найти в библиотеках компонентов поверхностного монтажа 
с помощью функций Browse (Просмотр) и Search (Поиск) в окне Component Library List 
(Список библиотек компонентов). В данном случае все конденсаторы представляют собой 
компоненты компании MuRata: все конденсаторы в схемах согласования и смещения серии 
GRM39 компании MuRata, а пропускающие РЧ конденсаторы – серии GRM36. Резисторы 
выбраны из серии CRCW марки Dale, а в качестве индуктивностей выбраны компоненты 
компании Coilcraft. Где возможно, компоненты выбирались со стандартным размером 
корпуса 0,060 x 0,030 дюйма, но индуктивности и пропускающие РЧ конденсаторы имеют 
другие размеры. Обратите внимание, что каждый компонент поверхностного монтажа 
задает имя используемого им компонента площадки SMT_Pad. Данный компонент 
SMT_Pad определяет размер площадки, которая будет использоваться в топологии, 
как показано на рис. 242. Разработчик должен задать это на странице схемы, чтобы 
обеспечить правильный вид площадок на топологии. Поскольку каждый пользователь 
задает площадки так, чтобы они подходили для применяемого именно им процесса 
изготовления плат, модели не содержат паразитных элементов площадок.

Как только будут вставлены компоненты и заданы площадки, разработчик может выбрать 
Layout > Place Components from Schematic to Layout (Топология > Вставить компоненты 
из схемы в топологию) и разместить каждый компонент в его приближенной позиции 
в окне топологии. Удобным способом создания межсоединений является применение 
проводников. Проводники могут быть преобразованы в эквивалентные микрополосковые 
компоненты с помощью команды Edit > Path/Trace/Convert Traces (Редактирование > 
Тракт/Проводник/Преобразовать проводники). Вообще говоря, при переходе из схемного 
представления в топологическое и обратно лучше работать с небольшими фрагментами 
и синхронизировать эти представления вручную. Синхронизация гарантирует то, что и 
топологическое, и схемное представления описывают одну и ту же схему. Например, если 
разработчик выполнил какие-либо изменения в топологии, схема может быть обновлена, 
так чтобы она отражала эти изменения, путем выбора команды Schematic > Generate/
Update Schematic (Схема > Сгенерировать/обновить схему) в окне топологии. Изменения, 
сделанные в схеме, могут быть аналогичным образом перенесены в топологию путем 
выбора команды Layout > Generate/Update Layout (Топология > Сгенерировать/обновить 
топологию) в окне схемы.

На рис. 243 показана окончательная топология. На слой металлизации на верхней стороне 
добавлена область земли для устранения необходимости в переходных отверстиях, 
что снижает стоимость изготовления. В ADS это можно легко сделать, нарисовав 
прямоугольник с размером окончательной печатной платы и воспользовавшись функцией 
Edit>Create Clearance (Редактирование > Создать зазор), чтобы сформировать требуемый 
зазор вокруг линий передачи и посадочных мест компонентов.

Рис. 242. Подстановка компонента поверхностного монтажа вместо идеального компонента требует 
применения компонента SMT_Pad (Площадка поверхностного монтажа).
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Наконец, в данном примере будет выполнена симуляция проекта в топологическом 
представлении, поэтому в диалоговом окне File > Design/Parameters (Файл > Параметры 
проекта) выбирается опция “SimLay” (Симуляция топологии). Это позволяет разработчику 
наблюдать влияние изменений в топологии непосредственно, без необходимости 
повторного ввода параметров в схему. Обратите внимание, что компоненты в схеме можно 
изменять (и даже полностью удалять) без влияния на симуляцию, пока топология остается 
неизменной.

Симуляция из топологического представления (ячейка: 
SimFromLayout)

Ячейка SimFromLayout содержит компонент топологии смесителя MixerLayout, а также 
контроллер симуляции, источники и нагрузки, необходимые для его симуляции. Схема 
для симуляции идентична той, которая использовалась в ячейке LOdrive, так что можно 
непосредственно сравнить результаты при применении неидеальных компонентов. В 
компоненте MixerLayout применяются микрополосковые линии, поэтому в проект также 
включен компонент “MSub” (рис. 244).

Рис. 243. Окончательная топология схемы смесителя.

Рис. 244. Компонент MixerLayout установлен в виде подсхемы в схему ячейки SimFromLayout.
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Изменение номинала Rl с 1,5 кОм до 3,3 кОм возвращает полученное при симуляции 
значение усиления преобразования к уровню 10,76 дБ, обеспечивая запас 0,76 дБ выше 
заданных технических требований. Обратите внимание, что для того, чтобы эти изменения 
отразились в результатах симуляции, они должны быть выполнены в файле топологии. 
Как только все подобные окончательные коррекции топологии будут выполнены, плата 
будет готова к передаче в производство.

Заключение
Был представлен пример разработки смесителя с помощью Keysight ADS, включая 
подробное описание процесса разработки и схем для симуляции. Этот пример включен в 
пакет Keysight ADS и может быть легко скопирован и модифицирован пользователями для 
своих проектов.

Дополнительная информация по разработке смесителя
Дополнительные материалы и различные примеры разработки смесителя можно найти в 
центре знаний САПР EEsof EDA компании Keysight: 
http://www.keysight.com/find/eesof-knowledgecenter

Поздравляем! Вы завершили раздел «Разработка активного смесителя». Дополнительные 
примеры вы найдете здесь:
www.Keysight.com/find/eesof-ads-rfmw-examples

На рис. 245 показано усиление преобразования как функция уровня сигнала гетеродина 
при симуляции как с идеальными компонентами, так и с моделями компонентов 
поверхностного монтажа. Как и ожидалось, усиление преобразования значительно 
снизилось, в основном из-за резистивных потерь в индуктивностях. Это можно проверить, 
заменяя отдельные компоненты их идеальными аналогами и вновь выполняя симуляцию. 
Теперь, чтобы скомпенсировать эти потери, можно скорректировать нагрузочный 
резистор:

Рис. 245. Сравнение усиления преобразования смесителя при применении идеальных компонентов и 
компонентов поверхностного монтажа.

http://http://www.keysight.com/find/eesof-knowledgecenter
http://www.Keysight.com/find/eesof-ads-rfmw-examples
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